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EASY 
 

 
 

USB UPGRADES 
 
Using an available USB (Universal Serial Bus) port, you can add up to 127 pieces of hardware to 
your computer or laptop.  USB ports are hot-swappable, meaning that you can add and remove 
devices while the computer is running.   USB 1.0 ports transfer data at 12 MB per second.  USB 
2.0 ports transfer data at 480 MB per second. 
  
 
 
 
 

 
 

USB HUB 
 

Split your current USB port into several additional ports.  USB hubs can be linked to each other 
to add even more available ports.  Some examples include: 
 

• 3-Port USB Hub with PS/2 Mouse & Keyboard Ports (Black) ($09 from Geeks.com) 
• Belkin Hi-Speed USB 2.0 4-Port Mini-Hub    ($23 from Geeks.com) 
• USB 2.0 7-Port Super Slim Compact Hub w/ LEDs   ($12 from Geeks.com) 
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EASY 
 
 

     
 

USB REMOVABLE STORAGE 
 

Also known as an external hard drive, flash drive or memory stick.  These devices plug into your 
USB port and add additional storage.   You can also move them from machine to machine.   Very 
cheap and useful - soon to replace floppy disks entirely. 
 

• 128MB USB 2.0 Flash Drive       ($05 from Geeks.com) 
• 512MB Memorex TravelDrive USB 2.0 Flash Drive    ($13 from Geeks.com) 
• 1GB USB 2.0 Portable Flash Drive      ($16 from Geeks.com) 
• 120 GB Western Digital WDXMS1200TN     ($91 from Amazon.com) 
• 500 GB Iomega Desktop Hard Drive      ($130 from Amazon.com) 
 

 
 

  
 

USB DRIVES 
 
Using your USB port, you can add an external floppy drive, external CD (or CD-RW drive), or 
external DVD (or DVD-RW) drive.  Often times, you can upgrade to a combination of drives. 

 
• LaCie 1.44MB USB External Pocket Floppy Disk Drive    ($25 from Geeks.com) 
• 24x USB External Slim CD-ROM Drive     ($14 from Geeks.com) 
• 24x10x24 USB 2.0 External Slim CDRW Drive    ($28 from Geeks.com) 
• I/OMagic 52x24x52x16 CDRW/DVD-ROM Combo Drive  ($69 from Geeks.com) 
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EASY 
 

   
 

USB PERIPHERAL HARDWARE 
 
Using your USB port, you can also connect a new sound card, an external modem, a scanner or 
printer, a digital camera, or your cell phone to your machine.  Almost all new peripheral devices 
come with USB ports. 

 
• SIIG USB SoundWave 7.1 Sound Card    ($21 from Geeks.com) 
• Hayes ACCURA H08-15355 56K V.92 USB Data/Fax Modem  ($42 from Geeks.com) 
• Canon CanoScan LiDE-25 48-bit USB Color Flatbed Scanner   ($52 from Geeks.com) 
 

 
 

  
 

USB FUN 
 
In addition, you can connect any or all of the following devices to your computer.  Most are for 
fun, but some can be quite useful. 
 

• USB Powered LED Lights (Ice Blue)     ($3 from Geeks.com) 
• USB Tech Lamp  (blue)     ($10 from ThinkGeek.com) 
• USB Drink Chiller & Warmer     ($25 from ThinkGeek.com) 
• PC Link USB Digital Microscope w/Metal Base   ($45 from Geeks.com) 
• 35mm Slide & Negative Digital Converter   ($100 from ThinkGeek.com) 
 
• USB Rubberized Roll-Up Piano or Drum Kit   ($28 from Geeks.com) 
• iAXE USB Electric Guitar     ($100 from ThinkGeek.com) 
• Ion USB Turntable (convert LPs to MP3s)   ($100 from ThinkGeek.com) 
• Ion USB Cassette Deck (converts cassette to MP3) ($150 from ThinkGeek.com) 
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EASY TO MODERATE 
 

 
 

LAPTOP PC CARDS 
 

Using your PC card slot (formerly known as PCMCIA - personal computer memory card 
international association), you can add additional internal devices to your laptop without having 
to open your machine.  All PC Card devices use an identical 68 pin dual row connecting interface.  
The card type (I to IV) is determined by the thickness of the PC card. 

 
 

 
Ethernet Card 
Add an Ethernet card if your machine does not have one and is unable to connect to DSL or 
cable modem connections.  You will need an Ethernet card to use the network connection at the 
library. 

• Sabrent NT-80211G Ethernet 10/100 network LAN Adapter  ($07 from Amazon.com) 
• NETGEAR FA511 32-bit CarBus PC Card Mobile (10/100)    ($35 from Amazon.com) 

 
TV/FM Tuner Card  
Turn your laptop into a TV/radio with a TV/FM tuner card.  Works with cable and antenna. 

• Sabrent TV PCMCIA Cardbus with FM Radio    ($40 from Amazon.com) 
• Notebook CardBus TV Tuner Card w/FM Radio/Video Capture  ($44 from Amazon.com) 

 
 
USB 2.0 Card 
Add additional USB ports (or USB 2.0 capability) to your laptop via the PC slot. 

• Sabrent SBT-P2D USB 2.0 CardBus Two Port     ($17 from Amazon.com) 
• MICRO INNOVATIONS usb750r Micro USB 2.0 4-Port PC Card  ($35 from Amazon.com) 

 
 
Wireless Network Card 
Check for and use available wireless network connections via your laptop.   

• Belkin F5D7010 Wireless 54 Mbps card     ($40 from Amazon.com) 
• Netgear WG511 Wireless 802.11g PC Card     ($60 from Amazon.com) 
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DESKTOP ISA/PCI CARDS 
 
You will need to open up your desktop computer to see how many available ISA and PCI slots 
you have before you perform this upgrade.   ISA (Industry Standard Architecture) slots are older 
and longer.  PCI (Peripheral Component Interconnect) slots are newer and shorter.  If at all 
possible, buy PCI cards and use your PCI slots for new hardware additions.   Make sure you turn 
off and unplug your computer and ground yourself first before installing these cards.  You will 
need a Philips-head screwdriver to free up available slots. 
 
Ethernet Card 
Add an Ethernet card to connect to DSL or cable modem connections.   

• Intel PWLA8391GTBLK PRO/1000 GT Desktop Network Adapter ($35 from Amazon.com) 
 

TV/FM Tuner Card  
Turn your desktop computer into a TV/radio with a TV/FM tuner card 

• Terminator Pci TV Tuner Fm Stereo with Remote 9BIT Color ($30 from Amazon.com) 
 

USB 2.0 Card 
Add additional USB ports (or USB 2.0 capability). 

• LACIE 107435 USB-2.0 PCI Card      ($20 from Amazon.com) 
 
Wireless Network Card 
Check and use available wireless network connections.   

• Linksys WMP54GS Wireless-G PCI Card with SpeedBooster  ($60 from Amazon.com) 
 
 
Video Card 
Add a new Video Card if you are receiving errors about your current one ("Unable to display") or 
if you wish to explore more graphics-intensive programs.  

• NVIDIA GeForce 7600GS 256MB PCI-Express Video Card   ($55 from Geeks.com) 
• Forsa GeForce 6600 128MB DDR PCI-E Video Card    ($40 from Geeks.com) 
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CHALLENGING 
 

  
 

 
MEMORY UPGRADE 

 
Add more RAM (Random Access Memory) if you want your computer to run faster.  To install 
additional RAM, you'll need to open up your computer (after unplugging it and grounding 
yourself) and see if you have any available memory sockets.  You will also want to note the type 
and number of memory chips you currently have installed. 
 
 
PURCHASING RAM: 
Visit the computer manufacturer's website to see if they have a guide to memory upgrades.  Dell 
has a great memory guide (including computers other than Dell machines) at: 
http://accessories.us.dell.com/sna/memconfig.aspx    
 
 
INSTALLING RAM: 
Complete steps at: http://www.ehow.com/how_895_install-ram.html  
 

1. Turn off and unplug your machine.  I'd also remove the battery if you're working on a 
laptop.  Ground yourself to prevent static from destroying the chip. 

2. Open up your computer and find the next available empty memory socket. 
3. Align the memory chip with the proper notches and insert at a 30 degree angle to the slot. 
4. Gently slide the chip in place and lock down. 
5. Replace the cover and turn on your computer. 
6. You should see the updated memory in the system startup.   If your computer does not 

start up, the memory is either incompatible or inserted improperly.  You'll need to power 
down your machine and recheck the chip 

7. If the machine starts up properly, you can confirm the memory addition by right-clicking 
"My Computer" and selecting "Properties". 
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CHALLENGING 
 

 
 

CPU UPGRADE 
 

A new CPU will make your computer run faster.  Upgrade your CPU (Central Processing Unit) if 
your computer has been working at maximum capacity.   
 
 
PURCHASING A NEW PROCESSOR: 
Visit the computer manufacturer's website to see if they have a guide to your processor type. 
There is also a third-party tool called CPUID (http://www.cpuid.com) that will tell you what type 
of processor you currently have installed in your system.   Do some research and see if there is 
an available upgrade for your processor.  
 
 
INSTALLING A NEW PROCESSOR: 
Complete steps at: http://www.ocf.berkeley.edu/~joyoung/cpu/page1.shtml  
 

1. Turn off and unplug your machine.  I'd also remove the battery if you're working on a 
laptop.  Ground yourself to prevent static. 

2. Open up your computer and remove the old CPU unit.  There is a metal lever that you will 
need to lift up to eject the processor. 

3. Insert the new processor and lock down into place.   
4. With newer processors, you will also need to install a cooling fan.  Make sure you connect 

the fan to the motherboard with the included cable. 
5. Replace the cover and turn on your computer 
6. If your computer does not start up, the processor is either incompatible or inserted 

improperly.  You'll need to power down and recheck the installation. 
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HARD DRIVE UPGRADE 

 
A new hard drive will offer more storage and (hopefully) a quieter computer.   You will, however, 
need to reinstall the operating system, all software and all personal files onto the new drive.   
 
PURCHASING A NEW HARD DRIVE: 
Unlike memory chips and processors, hard drives are more forgiving about what will work with 
your machine.  You may wish to visit your manufacturer's website to get a few tips about which 
models will work best. 
 
INSTALLING A NEW HARD DRIVE: 

1. Back up all documents that you've created onto an external hard drive or memory key. 
2. Turn off and unplug your machine.  I'd also remove the battery if you're working on a 

laptop.  Ground yourself to prevent static. 
3. Open up your computer and see how the hard drive is connected to the motherboard.  

Check the power cable and jumper configuration on the original hard drive.  If you have 
an extra connection, you might wish to use this for the secondary hard drive. 

4. You will need to attach power (red/yellow/black cables) and data connectivity (long, flat 
gray cable) to the new hard drive.  Often times, new hard drives come with extra cables. 

5. You will also need to use jumper settings and mark your new hard drive as the primary 
(master) drive, and your old hard drive as the secondary (slave) drive.   If you are using 
cable-select, make sure your new hard drive is in the first slot (A) instead of the second. 

6. Screw the hard drive firmly in place and reboot your machine. 
7. If your hardware installation was successful, you'll need to reinstall the operating system 

on the new hard drive.    If not, check your cabling (remember, you can undo everything 
at any time) 

8. Insert the installation CDs in your CD-ROM drive and reinstall your operating system onto 
the new hard drive. 

9. Reboot your computer.  See if it recognizes your old hard drive (D: or E:)  on boot. 
10.Copy program files and personal files onto the new hard drive. 
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REPAIR TIPS 

 
 
 

Laptop Repair:    
If your laptop does not start up (or does not shut down), unplug it and remove the battery.   
Replug the laptop with no battery and turn it on.  Once it's running, reinsert the battery.  If it 
doesn't restart, check the outlet and power cable to make sure everything is plugged in properly.  
You may need a new power adapter (or your laptop is truly broken). 
 
Computer Repair:   
If your computer does not start up (or shut down), try holding down the power button for three 
or more seconds.  This generally sends a command to start/shut down.  If that doesn't work, 
unplug the machine and wait for at least a minute (this gives the hardware a chance to 
completely stop).  Replug the machine and turn it on.   If it does not start up, test the wall outlet 
and power cable.   You might also have a bad monitor - check to make sure the monitor is 
working properly. 
 
 
On Startup: 
Write down any error messages at startup (including those on the first startup screen before 
Windows loads).  This will give you a hint as to what's causing the problem.   Find a computer 
with an Internet connection (i.e. the library public computers) and enter this error message, 
with quotes, into Google to see if other people are having similar problems. 
 
If Your Machine Starts, but Doesn't Load Windows: 
Try booting your computer in Safe Mode (minimal drivers and no networking).   Often times, this 
is done by hitting the F8 key (timing is essential) at startup and selecting "Safe Mode" from the 
black & white screen.  Once your computer has started in safe mode, try figuring out what is 
causing the problem (there might be a pop-up error message to write down.  Also check the 
Event Viewer - instructions listed below), then reboot the machine into regular mode. 
 
If Your Machine Starts and Loads Windows: 
Check the Error Logs for possible problems.   This is under Start → Programs → Administrative 
Tools → Event Viewer.   You can also reach it from:  Start → Settings → Control Panel →  
Administrative Tools → Event Viewer.  Event Viewer has the following logs:  Application, 
Security, System and Internet Explorer.   Look for anything that has a red Error mark next to it 
(you can filter events at View → Filter.  Note the date/time and Event ID of the error message 
(you may want to write down the complete error message).   Find a computer with an Internet 
connection and look up the error message.  Microsoft has their own site for error messages, but 
I prefer EventID:  http://www.eventid.net/      Enter your Error Number and scroll through the 
causes and solutions for this problem. 
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